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1 ようこそ、REAKTOR へ。
 

REAKTOR は音声を生成する楽器です。 そして MIDI キーボードと共にスタンドアローンとし
て、またはシーケンスソフト内でプラグインとして使用することで、他のソフトウェアと同様に操
作することが可能です。
ですがどんな楽器を使用するか選択するのはあなたです。 REAKTOR を起動する度に、あなたの
音楽センスをフォローします。 シンセサイザーが必要ですか? ドラムマシンが必要ですか? ある
いは効いたことがない音が出るノイズ生成マシンがお望みですか? お好きなインストゥルメント
ファイルをロードして、演奏を開始してください。
フルバージョンの REAKTOR では独立した 50 以上のインストゥルメントを装備しています。 
それらは近年の電子音楽を支えてきた初期の REAKTOR インストゥルメントを含んでいます。 
オンラインライブラリでは 3000 以上の様々なインストゥルメントを取り揃えています。
フルバージョンでなくても、REAKTOR エンジンを使用することが可能です。 別途で進化し続け
る KOMPLETE インストゥルメントを REAKTOR 用に用意しています。 インストゥルメントを
ロードする際に、REAKTOR がプレイヤーモードに切り替わります。 この解説は以下の↑1.2, 

REAKTOR 各モード: フル、プレーヤー、デモモード で行っています。
プリセットインストゥルメントをロードしてからが本領を発揮する場面です。 好きなインストゥ
ルメントのシグナルプロセッシングを編集することが可能で、内部構造を曲に合わせて調整、また
はインストゥルメントを最初から作成することで、自分だけのインストゥルメントを作成すること
が可能です。
この資料はそれらの操作の基本的な内容を解説します。
Native Instruments REAKTOR チームより

1.1 動作環境
 

新旧オペレーションシステムによる互換性と動作環境の最新情報に関しては、以下のサイトを参照
してください。
www.native-instruments.com/REAKTOR

ようこそ、REAKTOR へ。
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1.2 REAKTOR 各モード: フル、プレーヤー、デモモード
 

コンピュータにインストールしてある REAKTOR  のバージョンによって、どのモードの
REAKTOR を使用できるかが決まります。 このモードは以下の使用ライセンスによって異なり
ます。
▪ Full モード- REAKTOR を既にインストールしており、製品起動、または KOMPLETE 等の

バンドル製品内で起動している場合は、フルモード(Full)で使用することが可能です。 Full モ
ードでは全ての機能を制限無く使用することが可能です。

▪ Player モード- REAKTOR 用 KOMPLETE  インストゥルメント、または KOMPLETE 
Elements 等のバンドル製品をインストール、製品起動した場合と、 更に REAKTOR をイン
ストゥルメント用にプレイヤーとしてインストールした場合はモードが異なります。 この場
合、REAKTOR を Player モードで使用することとなります。 Player モードではインストゥ
ルメントを使用し設定内容を変更することが可能ですが、内部構造を編集することはできま
せん。 REAKTOR の Player モードでインストゥルメントを保存することはできませんが、
代わりに全てのインストゥルメントの設定内容はホストのプロジェクトとして保存可能とな
ります。

▪ Demo モード- REAKTOR といくつかの KOMPLETE インストゥルメントのデモバージョ
ンをインストールし、製品起動を行っていない場合、REAKTOR で使用するライセンスはデ
モですので REAKTOR はデモモードで起動します。 Demo モードで全ての機能を使用する
ことはできますが、30 分使用すると、音声の生成を停止します。 更に保存することもでき
ません。

インストールと製品起動については別途の Native Instruments セットアップガイドを参照してくださ
い。

1.3 初歩的な操作
 

この資料では REAKTOR の操作に必要な初歩的使用方法に関して解説します。

ようこそ、REAKTOR へ。
REAKTOR 各モード: フル、プレーヤー、デモモード
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▪ ↑2, REAKTOR の基本設定章、↑3, ロードと演奏章では、アプリケーションの設定方法、イ
ンストゥルメントのロードと再生方法について解説します。 この章の解説部分は全バージョ
ンユーザーに対して共通に必要な解説です。

▪ ↑4, REAKTOR アンサンブルの改造から↑9, 次は? 章までは REAKTOR のフルバージョン
ユーザー用解説となっています。

以下の章では REAKTOR でもっとも頻繁に使用する操作について解説します。 技術的詳細に関
わることなく、REAKTOR の機能を効率よく使用する方法について解説します。 以下の解説は飛
ばすことなく順番に読み進んでください。

1.4 REAKTOR 資料
 

REAKTOR の基本操作に慣れたら、更に詳細を編集したくなるでしょう。 REAKTOR リファレン
スマニュアルには REAKTOR 内の各アイテムと機能に関する詳細解説を含んでいます。
▪ アプリケーションリファレンス(Application Reference)では REAKTOR の全てのコン

セプトについて解説します。 この資料ではアプリケーション操作詳細について解説していま
す。 REAKTOR の操作方法について基本操作よりも一歩踏み込む場合、このアプリケーショ
ンリファレンス(Application Reference)が第一歩となります。

▪ インストゥルメントリファレンス(Instrument Reference)ではファクトリーコンテンツ
を含んだ REAKTOR の全インストゥルメントについて解説します。 各インストゥルメント
のオプション各について詳細を確認する場合はこの資料を参照してください。

▪ モジュール/マクロリファレンス(Module and Macro Reference)では REAKTOR で自
身のインストゥルメントを作成するための全ての部品について解説しています。 構造内の詳
細を設定する場合は、この資料がガイドとなります。

▪ コアリファレンス(Core Reference)は 2 つのパートに分かれており、チュートリアルの最
初の半分は REAKTOR のコアについて解説し、ここでどのようにデジタルシグナルプロセシ
ングデバイスを作成するか解説します。 次の半分では全てのコアレベルコンポーネントに関
する包括的なリ参照資料です。

これらの資料は REAKTOR をフルモードで使用する際に特に便利です。 アプリケーションリフ
ァレンスでは REAKTOR のインストゥルメントの使用方法について詳細解説しており、
REAKTOR を Player モードで使用する際にも便利です。

ようこそ、REAKTOR へ。
REAKTOR 資料
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全ての資料は REAKTOR の Help メニューに保管してあります。

REAKTOR の追加情報はオンラインで参照可能です。 Native Instruments のユーザーフォーラ
ムで確認してください。
http://www.native-instruments.com/forum/
REAKTOR ユーザーによるコミュニティで各ヒントを参照、または質問の解決に活用してくださ
い。

1.5 本マニュアルで私用する各フォーマットについて
 

本マニュアルでは、特定表記専用フォントを使用して特記事項や、危険事項について解説していま
す。以下の各アイコンで、特記事項内容の大まかな分類を見分けます。

このアイコンの後に表記してある内容には、必ず従ってください。

この電球アイコンでは有効なヒントとなる内容を記載してあります。ここではしばしば機能をよ
り効率よく使用するための解決策が記載されていますが、必ずこれを実行しなければならないとい
う内容ではありません。読んでおけば、役立つ内容となっています。

ようこそ、REAKTOR へ。
本マニュアルで私用する各フォーマットについて
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2 REAKTOR の基本設定
 

REAKTOR 5 は内蔵オーディオ/MIDI ハードウェアを介し、独自のインターフェイスを使用した
スタンドアローンとして使用可能です。 これによりコンピュータに接続した MIDI キーボード/コ
ントローラーを使用して REAKTOR を演奏することが可能です。 ここからの解説は REAKTOR 
をスタンドアローンアプリケーションで使用しているものとします。
この章では REAKTOR を コンピュータに接続してある MIDI 機器とオーディオハードウェアに
接続する方法を解説します。REAKTOR を DAW 上で使用する方法についても少し紹介します。
REAKTOR 5 で作業を開始する前にオーディオ設定をしておくとよいでしょう
この設定は REAKTOR 5 をスタンドアローンとして使用する場合に有効で、ホスト内での設定を
使用する REAKTOR 5 プラグインには関係ありません。

2.1 オーディオハードウエアの設定
 

REAKTOR が生成する音声を視聴できる状態にするには、REAKTOR を使用するためのオーディ
オハードウェア機器(サウンドカード、または外部オーディオインターフェイス)を設定する必要が
あります。

低レイテンシードライバの使用
REAKTOR を使用する際には低レイテンシードライバを使用してください。 REAKTOR 推奨ド
ライバは以下の 2 種類です。
▪ ASIO™
▪ Core Audio™ (Mac OS® X の場合)

これらの技術はソフトウェアとオーディオハードウェア間のデータ伝達を効率よく行うために開
発されたので、ライブでの使用にも適しています。

2.1.1 Audio and MIDI Settings... ダイアログへのアクセス
 

最初に REAKTOR を立ち上げる際に、Audio and MIDI Settings...が自動的に表示されるはずで
す。このダイアログは再度 REAKTOR から表示させることが可能です。
1. アプリケーションメニューを開くには、Menu ボタンをクリックします。

REAKTOR の基本設定
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2. File > Audio and MIDI Settings... と進んでメニューエントリを選択します。

2.1.2 オーディオハードウェア機器の選択
 

REAKTOR を使用するためのオーディオハードウェアの選択方法は以下です。
1. REAKTOR アプリケーションをダブルクリックして起動します。 Audio and MIDI 

Settings... ダイアログウインドウが表示されます。
2. Audio and MIDI Settings... ダイアログウインドウ内で、Device メニューをクリックして使

用可能なオーディオインターフェイスのリストを開きます。 オーディオハードウェアが 1
つしかない場合は、その機器とサンプルレートが自動的に選択されます。 コンピュータに 2
つ以上の機器が接続してある場合、REAKTOR で使用する機器を任意で Device メニューか
ら選択します。

REAKTOR の基本設定
オーディオハードウエアの設定
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3. Driver メニューで、使用するドライバを選択します。 Windows® システム上では、ASIO™ 
を使用することを推奨します。 Mac OS® X では、Core Audio™ が選択されます。

REAKTOR の基本設定
オーディオハードウエアの設定
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オーディオハードウェア機器とドライバを選択したので、サンプルレートを選択することでオーデ
ィオハードウェアを設定します。

2.1.3 サンプルレートの選択
 

1. Sample Rate メニューからオーディオハードウェアで使用するサンプルレートを選択しま
す。 推奨するサンプルレートは 44100 Hz です。

REAKTOR の基本設定
オーディオハードウエアの設定

 

REAKTOR 5.5 - クイックスタートマニュアル - 19



2. サンプルレートを選択したのでアウトプットレイテンシーを設定します。

2.1.4 アウトプットレイテンシーの選択
 

オーディオハードウェアのアウトプットレイテンシーを調節することで、MIDI キーボードの操作
によって REAKTOR が音声を生成するまでの速さを調整します。 ノイズやクリック音を生成す
ることがないレイテンシーの最小値は使用している CPU パワーがどれだけオーディオ生成に割
り当てられるかによります。 近年のコンピュータでは正しく設定されれば耳で確認できるような
音声の遅れが生じることはありません。 旧型のコンピュータではレイテンシー設定を十分にとる
必要があります。 REAKTOR のレイテンシーの調整最適値は使用しているシステムによって異
なります。

REAKTOR の基本設定
オーディオハードウエアの設定
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Windows®
1. Audio and MIDI Settings...  ダイアログで ASIO Config をクリックしてオーディオハード

ウェアのコントロールパネルを表示します。

2. オーディオハードウェアのコントロールパネルでアウトプットレイテンシーを 10 ms 程度
にします。 この設定値は殆どのコンピュータシステムで有効な値です。

REAKTOR の基本設定
オーディオハードウエアの設定
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3. 設定が終わったら、 OK をクリックして値を適用します。

Mac OS® X
1. Audio and MIDI Settings... ダイアログの下部にある Latency スライダーの値を 256 サン

プル程度にします。

REAKTOR の基本設定
オーディオハードウエアの設定
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2. 設定が終わったら、 OK をクリックして値を適用します。

2.1.5 ルーティング-REAKTOR の各インプットのアサイン
 

REAKTOR のインプットチャンネルをオーディオデバイスの各インプットにアサインします。
1. Audio and MIDI Settings... ダイアログ上部にある Routing タブをクリックします。 Mac 

OS®  X を使用していて内蔵インプットを使用する場合は、“Audio MIDI Setup.app”を使用
して機器を設定する必要があります。

2. Inputs ボタンをクリックしてインプットビューを表示します。
3. REAKTOR のインプットをオーディオハードウェアデバイスのインプットにアサインするに

は、インプットビューの右にある任意のエントリーをクリックします。

REAKTOR の基本設定
オーディオハードウエアの設定
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4. 選択が終わったら、 OK をクリックして設定を適用します。

2.1.6 ルーティング-REAKTOR の各アウトプットのアサイン
 

REAKTOR のアウトプットチャンネルをオーディオデバイスの各アウトプットにアサインしま
す。
1. Audio and MIDI Settings... ダイアログ上部にある Routing タブをクリックします。 Mac 

OS®  X を使用していて内蔵アウトプットを使用する場合は、“Audio MIDI Setup.app”を使
用して機器を設定する必要があります。

2. Outputs ボタンをクリックしてアウトプットビューを表示します。
3. REAKTOR のアウトプットをオーディオハードウェアデバイスのアウトプットにアサインす

るには、アウトプットビューの右にある任意のエントリーをクリックします。

REAKTOR の基本設定
オーディオハードウエアの設定
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4. 選択が終わったら、 OK をクリックして設定を適用します。

2.2 MIDI ハードウェアの設定
 

1. Audio and MIDI Settings... ダイアログで MIDI タブをクリックします。 そこではコンピュ
ータに接続してある機器リストを表示しています。

2. 使用する機器の右にある Off テキストをクリックしてください。 するとテキストが On と
表示され、この機器が起動します。

REAKTOR の基本設定
MIDI ハードウェアの設定
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REAKTOR の基本設定
MIDI ハードウェアの設定
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3 ロードと演奏
 

このチュートリアルではプリセットインストゥルメントのロードと演奏方法について解説します。
▪ REAKTOR ブラウザを使用して REAKTOR アンサンブル(Ensembles)を開く方法を解説し

ます。
▪ スナップショット(Snapshots)についても紹介します。
▪ 最後に編集内容の保存方法について解説します。

このチュートリアルでは REAKTOR 、REAKTOR Factory Selection、各 KOMPLETE インスト
ゥルメントがインストールしてあることを前提に解説を勧めます。 また REAKTOR をホストシ
ーケンサー内でプラグインとして使用していることとします。

REAKTOR のフルライセンスをお持ちの場合、REAKTOR Factory Selection パッケージをインストー
ルする必要は無く、この例で使用するインストゥルメント Carbon 2  は、REAKTOR のファクトリー
コンテンツを New Additions > Synthesizers と進むと保管してあります。

3.1 いくつかの重要なボタン
 

操作を始める前に、Main Bar(メインバー) と Sidepane(サイドペイン) にあるボタンについて知
っておくとよいでしょう。
▪ メインバーにある Sidepane ボタンで Sidepane の表示切替を行います。 Sidepane には 

Browser、 Snapshot、 Panelsets、Properties の各タブがあります。

3.1 Sidepane ボタンです。

▪ Browser タブをクリックしてブラウザを開き、REAKTOR 内でファイルを探すのに使用しま
す。

3.2 Browser タブです。

ロードと演奏
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▪ Snapshot ボタンをクリックしてスナップショットブラウザを表示し、プリセットのロード、
保存、モーフィングに使用します。

3.3 Snapshot ボタンです。

▪ ここからはグローバルメニューエントリーにアクセスするには常に Menu ボタンを使用しま
す。 これら全てのメニューエントリーにはアプリケーションメニューからアクセスすること
も可能です。

3.4Menu ボタンです。

ロードと演奏
いくつかの重要なボタン
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3.5 アプリケーション File メニュー(図は Windows® での表示画面です)です。

 View メニューのグローバルメニューから REAKTOR の全表示画面にアクセスすることが可能です。
この注釈はこれ以降本マニュアルでは表記しません。

これらのボタンはこのチュートリアルでも頻出します。 ではブラウザ(Browser) を使用して最初
の REAKTOR アンサンブル(Ensemble)をロードしましょう。

3.2 アンサンブル、インストゥルメント、KOMPLETE インストゥ
ルメント

 

各ボタンの他にも、 REAKTOR ユーザーの間とこのチュートリアルでは頻出する以下のキーワー
ドの意味を理解しておくとよいでしょう。

ロードと演奏
アンサンブル、インストゥルメント、KOMPLETE インストゥルメント
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▪ Ensemble (アンサンブル)は REAKTOR に直接ロード可能なインストゥルメントのセット
です。 これは 1 台のシンセサイザー、またはいくつかのエフェクトを備えたチャンネルスト
リップ群となります。 各インストゥルメントはお互いに接続され、アプリケーションのイン/
アウトプットに接続されています。 保存を行う場合は殆どこの Ensemble ファイル形式で
保存されます。

▪ Instrument (インストゥルメント)はアンサンブルの一部で、例えば単一のディレイがそれ
となります。 アンサンブル内にインストゥルメントをロードすることも可能で、これらをア
プリケーションのオーディオイン/アウトプットに接続します。

▪ KOMPLETE Instrument は Player ライセンスをお持ちの際にのみ使用可能なファイルで
す。 構造的にはアンサンブルに近く、音楽的にはインストゥルメントの性質をかねています。

3.3 Carbon 2 のロード
 

まず初めに、REAKTOR Factory Library に含まれる減算方式のシンセシンセ Carbon 2 を開き
ます。

3.3.1 サイドペインの展開
 

起動後に表示されていない場合は、REAKTOR のファイルブラウザを含んだサイドペイン
(Sidepane)を開く必要があります。 サイドペインを開くにはメインバー Sidepane ボタンをクリ
ックします。

3.6 Sidepane ボタンです。

3.3.2 ブラウザを開く
 

サイドペインを開いた状態で、Browser タブをクリック、またはコンピュータキーボードの [F5] を
押します。

3.7 Browser タブです。

ロードと演奏
Carbon 2 のロード
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この動作でサイドペインがファイルブラウザ(File Browser)を開きます。このブラウザは 3 セク
ションに分割されており、最上部で 4 種類のファイルにアクセスする 4 つのボタンがあります。
その下はフォルダツリーです。その下はツリーで選択したフォルダ内にあるファイルのリストを
表示します。
ブラウザ最上部で Player ボタンをクリックします。 上のエリアに KOMPLETE インストゥルメン
トがリスト表示されます。 REAKTOR Factory Selection パッケージをマウスでクリックして選
択します。

ロードと演奏
Carbon 2 のロード
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3.1 Factory Selection を選択した状態のブラウザです。

Player ボタンの隣のボタンは REAKTOR の起動状況によってその表示内容が異なります。 REAKTOR 
を起動した直後は“Factory”と表示され、ファクトリーコンテンツを表示するボタンとなっています。 そ
れまでは “Demo” と表示されます。 これはアンサンブルをロードすると REAKTOR がデモモードで起
動することを意味します。

ロードと演奏
Carbon 2 のロード
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3.3.3 ファイルのロード
 

REAKTOR Factory Selection を選択すると、ブラウザの下のエリアにインストゥルメントのリ
ストが表示されます。 Carbon 2 をクリックしてアプリケーションのメインエリアにドラッグし
てください。すると REAKTOR がファイルをロードします。

3.4 Carbon 2 と各スナップショットを演奏する
 

3.2 REAKTOR Player に Carbon 2 をロードした状態です。

Carbon 2 はオシレータセクション、フィルター、モジュレーションソース、エフェクトを装備し
たクラシックな減算方式のシンセです。

ロードと演奏
Carbon 2 と各スナップショットを演奏する
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Instrument Reference 、または REAKTOR Factory Selection の資料を参照して Carbon 2 の詳細
を確認してください。

3.4.1 スナップショットのロード
 

MIDI キーボードを使用してシンセサイザーのサウンドを確認してください。その後異なるスナッ
プショットをロードすることで、サウンドを完全に変化させましょう。
スナップショットは REAKTOR 内でサウンド、プリセット、パッチを意味する用語です。 各イン
ストゥルメントでスナップショットを所持することが可能で、これらのスナップショットをロード
することでそのインストゥルメントのコントロール値を別の値に設定し、特定のサウンドを再現し
ます。
Carbon 2 のスナップショットはアプリケーションのメインバーのコントロール部からアクセス
することも可能です。

ロードと演奏
Carbon 2 と各スナップショットを演奏する
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3.3Snapshot コントロールです。

1. Snapshot コントロールをクリックしてドロップダウンメニューを表示します。メニューに
はインストゥルメントの全スナップショットを備えています。

2. In Deep を選択します。
3. 演奏してサウンドが変化しているか確認してください。

ロードと演奏
Carbon 2 と各スナップショットを演奏する
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3.5 サウンドの調節
 

このセクションでは基本的な調節によるサウンドの編集について解説します。

3.5.1 エフェクトの切り替え
 

スナップショット In Deep ではディレイエフェクトを使用することで空間的なサウンドを生成し
ます。 この例ではそういった空間的な演出を必要しないものとし、Delay ボタンをクリックするこ
とで効果を無効にします。 ディレイの代わりに、Chorus ボタンをクリックしてサウンドにステレ
オ効果を付加します。

3.4 Chorus と EQ を起動した状態の Effects タブです。

3.5.2 フィルターの動きの変更
 

また、フィルターの動きも変更してみましょう。

ロードと演奏
サウンドの調節
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1. フィルターの動きを操作するには、インストゥルメントの右側のタブをクリックして Source 
セクションに切り替えます。

2. 同様に Source の下部のタブで LFO1 を選択します。
3. Rate ノブをクリック/ドラッグしてコントロール値を 8 に変更します。
4. 演奏してフィルターの動きが倍になったか確認してください。

3.5 変更内容を適用した後の Source タブ内の LFO セクションです。

3.5.3 フィルター設定の変更
 

フィルター自体の変更方法は以下となっています。
1. インストゥルメントの Filter セクションで Resonance ノブをクリックし、値が 0.5 になる

までドラッグします。 これで音声の変化がより顕著となります。
2. 同じようにノブをドラッグして Cutoff 値を上げ、サウンドに輝きを付加します。

ロードと演奏
サウンドの調節
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3.6 編集した後の Filter セクションです。

3.6 編集内容の保存
 

編集したサウンドの保存方法は 2 通りあります。
▪ ホストのプロジェクトファイルを保存する。最も頻繁に使用する保存方法で、REAKTOR を 

Player モードで使用する場合はこの方法のみで保存することが可能です。 保存の際に、ホス
トアプリケーションが設定内容を再現する為に 保存する必要がある REAKTOR プラグイン
の全情報を記憶します。 ホストプロジェクトを次回起動すると、REAKTOR は保存したとき
の状態を再現します。

▪ アンサンブルファイルの保存。 フルライセンスの REAKTOR を使用している場合にこの方
法での保存が可能となります。 この場合、上述したチュートリアルでロードしたファイルの
編集したコピーを作成します。 その後他のソング内でこのサウンドをロードして使用するこ
とが可能となります。

ロードと演奏
編集内容の保存
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ホストプロジェクトの保存詳細に関してはホストの資料を参照して確認してください。

オリジナルインストゥルメントの複製となるアンサンブルファイルを保存するには、アプリケーシ
ョンメニューで Save As...エントリーを選択します。 これによってフォルダとファイルメニュー
を指定する為のデフォルトウインドウが表示されます。 保存場所とファイルメニューを指定した
後、Save ボタンをクリックします。

ロードと演奏
編集内容の保存
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4 REAKTOR アンサンブルの改造
 

このチュートリアルでは以下の内容を解説します。
▪ ここでは既存の REAKTOR アンサンブルの一つ、 Junatik を使用します。 Junatik はシン

セとディレイを供えたインストゥルメントです。
▪ この構造内に Reverb インストゥルメントを追加し、シンセに接続します。
▪ Delay インストゥルメントは削除します。
▪ REAKTOR のスナップショットシステムについても更に解説します。
▪ ブラウザを使用して Junatik をロードし、更に Reverb インストゥルメントをインサートし

ます。

REAKTOR PLAYER を使用している場合は、ここから先を読む必要はありません。 2、3 章を読めば、
後は自由に使用してください。

4.1 おさらい
 

最初のチュートリアルでは Append ボタンを使用してスナップショットを作成、保存する方法を
紹介します。 Save Ensemble As...コマンドを使用してプロジェクトを保存します。 これらの操
作方法を以下でも繰り返すので、最初のチュートリアルを十分に理解してから次のセクションへと
読み進んでください。

REAKTOR ボタンの使用
まず一度最初のチュートリアル内容を確認します。
▪ メインバーにある Sidepane ボタンをクリックして Sidepane の表示切替を行います。 

Sidepane には Browser、 Snapshot、 Panelsets、Properties の各タブがあります。

4.1 Sidepane ボタンです。

▪ Browser タブをクリックしてブラウザを表示します。

REAKTOR アンサンブルの改造
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4.2Browser タブです。

▪ Snapshot タブをクリックしてスナップショットリストを表示します。

4.3Snapshot タブです。

このチュートリアルでは REAKTOR のプロパティについて解説します。 ストラクチャー
(Structure)ボタンに関しても解説します。
▪ Properties タブをクリックして REAKTOR Ensembles、 Instruments、 Macros、 Modules 

等の各プロパティを表示します。

4.4Properties タブです。

▪ ストラクチャー(Structure)ボタンをクリックして REAKTOR のストラクチャーを開きます。

4.5Structure ボタンです。

これらのボタンとアイコンについて把握しておくと、REAKTOR をプラグインとして使用した場
合に便利です。

4.2 ブラウザを使用してアンサンブルをロードする。
 

もう一度、ブラウザを使用してアンサンブルをロードしましょう
1. Sidepane ボタンをクリックして Sidepane を表示します。
2. Browser タブをクリックしてブラウザを開きます。
3. Factory ボタンをクリックして Factory Library を操作します。
4. ブラウザ上部にあるフォルダツリーを使用して、Ensembles > Classics > Synthesizer と進

みます。 ここまでの操作で、ブラウザ下部にシンセのリストが表示されます。

REAKTOR アンサンブルの改造
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5. ブラウザ下部で Junatik をダブルクリックしてこのシンセをロードします。

4.6 ブラウザ内の Junatik です。

4.3 アンサンブル内のインストゥルメント
 

このセクションでは REAKTOR のアンサンブル内部の構造について解説します。

REAKTOR アンサンブルの改造
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4.3.1 Junatik パネル
 

4.7StereoTDelay を最小化した状態の Junatik Synth です。

Junatik パネルです。 どの部分がシンセかお分かりでしょうか?(Junatik と記載してあります)。 
シンセの下には StereoTDelay とあります。 アンサンブルパネルを見やすくする為に、インスト
ゥルメントは時々こうして隠されています 。  こ の 部 分 に は 、 名 称 の 通 り  Junatik 内 の  
StereoTDelay を収納しています。
▪  右下にある A ボタンをクリックして表示します。 A、B ボタンの隣にある— ボタンでサイド

このパネルを収納します。

REAKTOR アンサンブルの改造
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4.8StereoTDelay の全てを表示した状態です。

4.3.2 アンサンブルとインストゥルメントの違い
 

2-Osc を見ると、ディレイはシンセに内蔵してあります。 ここではディレイは別のインストゥル
メントとして存在しています。 REAKTOR においてアンサンブルは複数のインストゥルメント
を装備することが可能です。 今回の場合は、 2 つのインストゥルメントである、Junatik シンセ
と StereoTDelay を含んでいます。
REAKTOR ではインストルメントはシンセ、サンプラーまたはディレイやリバーブのようなエフ
ェクト、更にはシーケンサー、または画像でさえもインストゥルメント(Instrument)として扱いま
す。

REAKTOR アンサンブルの改造
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4.9Junatik インストゥルメントです。

4.10Delay インストゥルメントです。

REAKTOR アンサンブルの改造
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ノートを演奏すると、シンセ音声とディレイによる音声を聞き取ることができます。まずスナップ
ショットを変更し、異なるサウンドにしてみましょう。 Junatik は独立したシンセインストゥル
メントとエフェクトインストゥルメントから成り立っているので、スナップショットのシステムが
多少異なります。

4.4 プラグイン用スナップショットマスターとスナップショットの
構造

 

アンサンブルの最上部には Ens – Junatik と表示されたパネルがあります。

4.11Ensemble パネル

Ensemble パネルにはスナップショット 83 – Berlin ambience II  があります。

4.4.1 プロパティー内のスナップショット構造の確認
 

プロパティ(Properties)でスナップショットの構造を把握する必要があります。確認を行うには
以下に従ってください。
1. Ens – Junatik をダブルクリックします。 別の方法として、Sidepane の Properties タブを

クリックします。

2. Function ボタンをクリックして Junatik のプロパティの Function ページを表示します。
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4.12Function ボタンです。

4.13Recall by MIDI と Snapshot Master をチェックした状態の Ensemble プロパティです。

REAKTOR アンサンブルの改造
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プロパティ上部の Snapshot エリア内にある Recall by MIDI と Snapshot Master for Plug-In にチェック
がしてあるか確認してください。

4.4.2 Recall By MIDI と Snapshot Master for Plug-in
 

▪ Snapshot Master for Plugin はアンサンブル(マスター)でスナップショットを変更すると、
シンセとディレイのスナップショットも変更されることを意味します。 言い換えると、
Junatik インストゥルメントと StereoTDelay インストゥルメントはマスターであるアンサ
ンブルと同調するということになります。

▪ Recall by MIDI はこのインストゥルメントがプログラムチェンジメッセージを受信できるよ
うにする項目です。 マスターでこの設定を使用して同じ MIDI チャンネルを共用する場合
は、マスターのスナップショットが優先されます。

4.4.3 Junatik インストゥルメントのスナップショットプロパティ
 

Junatik パネルをクリックすると、Recall by Parent にチェックしてあるはずです。

4.14Recall by Parent にチェックした状態の Junatik インストゥルメントプロパティの Snapshot エリアです。

これでアンサンブルパネルのスナップショットをマスタースナップショットとして適用します。
スナップショットを変更して Junatik インストゥルメント内で異なるスナップショットを試す
と、時々 StereoTDelay インストゥルメントに異なるスナップショットが配備される場合があり
ます。 ここではスナップショット“24 – Pointer 1”を選択します。 すると、StereoTDelay スナ
ップショットは 1 – Delay off と表示されます。 Junatik インストゥルメントで様々なスナップ
ショットを試しその変化を確認してください。

REAKTOR アンサンブルの改造
プラグイン用スナップショットマスターとスナップショットの構造

 

REAKTOR 5.5 - クイックスタートマニュアル - 48



4.4.4 REAKTOR スイッチをオフにした状態のスナップショット
 

Junatik インストゥルメントのスナップショットの全てにディレイを適用していません。 
StereoTDelay の Snapshot 1 のディレイは Wet ノブの上にある On スイッチがオフの状態なの
で、無効の状態となっています。

4.15Delay スイッチはオフの状態です。

こういったスイッチはインストゥルメントをオフにするだけではなく、CPU も節約します。 この
アンサンブルを DAW で使用し、DAW のエフェクトを使用する場合は、このスイッチは Off に
しておくとよいでしょう。

4.4.5 スナップショットの柔軟性
 

StereoTDelay インストゥルメント内でスナップショットを変更すると、シンセスナップショット
を変更することなく、いくつかの選択肢からディレイエフェクトを選択することになります。 異
なるスナップショットを使用して異なるインストゥルメントを用いることで表現が多彩になり、ス
ナップショットマスターを使うことで複数のインストゥルメント上でスナップショットを変更可
能となります。

REAKTOR アンサンブルの改造
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4.5 ディレイインストゥルメントをリバーブインストゥルメントと
取り替える

 

Junatik シンセは気に入っているのでそのまま使用することにし、ディレイエフェクトをリバーブ
と交換してその音声を試してみましょう。 ディレイの代わりとなる REAKTOR のリバーブを探
してみましょう。

4.5.1 REAKTOR ストラクチャーを開く
 

リバーブを探す為に、アンサンブルの構造(Structure)を確認しましょう。
▪ サイドペインの Structure ボタンをクリックします。

4.16Structure ボタンです。

これでアンサンブルストラクチャー(Ensemble Structure)を開きます。

4.17Junatik のアンサンブルストラクチャーです。

REAKTOR アンサンブルの改造
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ご覧のように、Junatik シンセと StereoTDelay が接続してあります。 Junatik のアウトプット 
L (Left) と R (Right) は StereoTDelay のインプット L と R に接続してあります。 
StereoTDelay の L と R Outputs は Audio Out ターミナルへと繫がっています。
この後ブラウザを用いてアンサンブルストラクチャー内にリバーブをインサートします。 リバー
ブは Junatik インストゥルメントに接続します。 しかしその前に、ストラクチャー内から 
StereoTDelay を削除する必要があります。

4.5.2 ストラクチャーからインストゥルメントを削除する。
 

このアンサンブルストラクチャーからディレイを削除する方法は以下となっています。
1. ストラクチャーウインドウ内の StereoTDelay オブジェクトを Mac OS®  X では Ctrl-クリ

ック、Windows®  では 右クリックし、メニューを表示します。
2. マウスで Delete メニューエントリーをハイライト表示し、クリックします。 この手順でス

トラクチャーからインストゥルメントを削除します。

REAKTOR アンサンブルの改造
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4.18 インストゥルメントの削除

StereoTDelay インストゥルメントは削除された状態となるはずです。

4.6 ブラウザを使用したインストゥルメントの検索
 

そ れ で は リ バ ー ブ イ ン ス ト ゥ ル メ ン ト を 追 加 し ま し ょ う 。  ブ ラ ウ ザ を 使 用 し て  
SpaceMaster.ism をロードします。
1. サイドペインで Browser タブをクリックして REAKTOR ブラウザを表示します。

REAKTOR アンサンブルの改造
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2. ブラウザのフォルダツリーで Instruments > Effects と進みます。

3. ブラウザの下部で Space Master 1 – Stereo.ism をストラクチャーエリアにクリックドラ
ッグします。 この動作でアンサンブルストラクチャーにインストゥルメントを配置します。

REAKTOR アンサンブルの改造
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4.19SpaceMaster がストラクチャーに配置された状態です。

% ストラクチャーを右クリックして追加可能なインストゥルメントを含むメニューを開くことも可能で
す。

REAKTOR アンサンブルの改造
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4.20 パネルビュー内の SpaceMaster です。

4.7 オーディオアウトにインストゥルメントを接続する。
 

では Junatik を SpaceMaster Reverb に接続し、SpaceMaster Reverb を Audio Out ターミ
ナルに接続します。

4.7.1 接続方法
 

1. Junatik インストゥルメントの L Output(または隣の点)をクリックホールドし、マウスを
SpaceMaster の L Input にドラッグします。 この際、マウスを動かすとワイヤーが現れ、
カーソルが指に変わります。 SpaceMaster の L Input または隣のドットに到達したら、マ
ウスを放してください。

REAKTOR アンサンブルの改造
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2. この方法で全接続を行います(SpaceMaster の L と R Outputs から Audio Out ターミナ
ルの 1 と 2 Inputs への接続を含む)。

ここまでを終えると、ストラクチャーの見た目はこうなります。

4.21SpaceMaster を Junatik と Ouputs に接続した状態です。

ここまでを終えたら、アンサンブルパネルで 2 つのインストゥルメントの見た目を確認してくだ
さい。

REAKTOR アンサンブルの改造
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4.7.2 アンサンブルパネル内のインストゥルメントの位置をリセットする。
 

ここまでの作業で、アンサンブルパネル内の Junatik インストゥルメントの上に SpaceMaster 
インストゥルメントが配置される場合がありますが、すでに SpaceMaster インストゥルメントが
下にある場合以下の作業はスキップしてください。位置を変更するには、以下を行ってください。
1. サイドバーの Panel ボタンを押して Panel View に切り替えます。

2. SpaceMaster Panel をクリックしてください。
3. その後インストゥルメントをクリックドラッグしてインストゥルメントを Junatik の下にド

ラッグしてマウスを放すと移動します。 この作業によって Junatik が上部に移動します。

REAKTOR アンサンブルの改造
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4.22Junatik が上に移動した状態です。

4.8 正しいスナップショット順序の復元
 

順番が変わったスナップショットの構造内に SpaceMaster を挿入します。 アンサンブルはプラ
グイン用 Snapshot Master ですので、Snapshot Master 内の順番を直す必要があり、 そのた
めに Junatik インストゥルメントと、SpaceMaster インストゥルメントのプロパティを変更する
必要があります。

REAKTOR アンサンブルの改造
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4.8.1 インストゥルメントプロパティを開く
 

まず Junatik Ensemble で Snapshot Master for Plug-In 機能を再度設定し、SpaceMaster 
で Recall by Parent 機能をオンにします。
1. サイドペインで、 Properties タブをクリックします。

2. Ens – Junatik ヘッダをクリックします。 この動作で Junatik Ensemble プロパティが開き
ます。

3. Function ボタンをクリックします。

4. Snapshot エリアの Snapshot Master for Plug-In ボックスをチェックします。

5. SpaceMaster パネル名称部をクリックします。 この動作で SpaceMaster プロパティが開
きます。

6. Recall by Parent ボックスにチェックを入れます。

REAKTOR アンサンブルの改造
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5 シーケンサー機能付きシンセサイザーの作成
 

このチュートリアルではシーケンサー付シンセを作成します。

5.1 おさらいと概要
 

Junatik アンサンブルの構造は、Junatik シンセインストゥルメントと StereoTDelay インストゥ
ルメントから成り立っています。 これから REAKTOR インストゥルメントを 2 つ用いてアンサ
ンブルを作成します 。  使 用 す る イ ン ス ト ゥ ル メ ン ト は シ ー ケ ン サ ー の  Monoliner と 
Soundschool Analog (短縮して ANALOG とも呼びます)シンセです。
Monoliner はクラシックスタイルのアナログシーケンサーで、3 列分のノブ群を備え、
Soundschool Analog はクラシックセミモジュラーで、2 つのオシレータを備えたアナログシン
セです。
ここで MIDI とオーディオ の接続を行い、シーケンサーがシンセをトリガーするように設定しま
す。

シーケンサー機能付きシンセサイザーの作成
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5.1Monoliner と Soundschool Analog (ANALOG)です。

5.2 シンセシーケンサーアンサンブルの作成
 

新規アンサンブル(New Ensemble)から始め、インストゥルメントを追加しましょう。

5.2.1 新規アンサンブル(New Ensemble)の作成
 

▪ Menu ボタンを押して File > New Ensemble と進み、新規アンサンブルを作成します。

シーケンサー機能付きシンセサイザーの作成
シンセシーケンサーアンサンブルの作成
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5.2 グローバルメニュー内の New Ensemble メニューエントリーです。

5.3 新規アンサンブルのパネルです。

キーボードショートカット [Ctrl]+[N]Windows®(Mac OS® X では [Cmd]+[N]) で新規アンサンブルを
作成することも可能です。

シーケンサー機能付きシンセサイザーの作成
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5.2.2 ブラウザを使用してインストゥルメントをロードする。
 

1. サイドペインで Browser タブをクリックしてブラウザを開きます。

2. Factory ボタンをクリックしてファクトリーライブラリに移動します。

3. ブラウザのフォルダツリーを使用して Instruments > Sequencers と進みます。
4. ブラウザ下部から Monoliner.ism を右のパネルエリアにドラッグします。 この動作で 

Monoliner がアンサンブルに設置されます。

シーケンサー機能付きシンセサイザーの作成
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次にブラウザを使用して Soundschool Analog をロードします。
1. フォルダツリーで Instruments > Synthesizers と進みます。
2. Soundschool Analog.ism がある場所までスクロールダウンします。
3. Soundschool Analog.ism を右にあるパネルエリアへとドラッグします。

シーケンサー機能付きシンセサイザーの作成
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5.4 アンサンブルに SoundSchool Analog を設置します。

5.3 シンセシーケンサーの各設定
 

MIDI 接続を行い、Monoliner と Soundschool Analog がやり取りを行えるようにする必要があ
ります。

シーケンサー機能付きシンセサイザーの作成
シンセシーケンサーの各設定

 

REAKTOR 5.5 - クイックスタートマニュアル - 65



5.3.1 ストラクチャー概要
 

ロードを終えると、ストラクチャーの見た目はこうなります。

5.5Monoliner と ANALOG をロードした状態のアンサンブルストラクチャーです。

Monoliner と ANALOG インストゥルメントと、デフォルトの状態の空のインストゥルメントが 
Audio In と Audio Out 各ターミナルに接続された状態で表示されています。 まずこのストラク
チャーから不要なインストゥルメントを取り除きます。

5.3.2 不必要なインストゥルメントの削除
 

▪ インストゥルメント上部で Windows® では右クリック( Mac OS® X では[Ctrl]++クリッ
ク) し、メニューで Delete を選択します。

シーケンサー機能付きシンセサイザーの作成
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5.6 メニューを使用してインストゥルメントを削除します。

ストラクチャー内で ANALOG Synth  の L/R Outputs から、Audio Out ターミナルの Input 
1/2 へ接続します。

5.3.3 ANALOG アウトプットを Audio Out に接続する。
 

この作業は Junatik synth  と SpaceMaster Reverb の接続と同等の内容です。
1. クリックドラッグすると、L(またはすぐ横の黒点)から Audio Out の間に配線ケーブルが表

示されるので、マウスを放します。 これで接続が完了します。
2. R Output と Audio Out ターミナル 2 でも同じ作業を行ってください。
ここまででストラクチャーの見た目が図のようになります。

シーケンサー機能付きシンセサイザーの作成
シンセシーケンサーの各設定
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5.7 オーディオアウトプットに接続した状態の ANALOG です。

Master インストゥルメントはマスターレベルフェーダーを使用するのでそのままにしておきま
す。ここからはアンサンブルパネルで 2 つのインストゥルメントの解説を行います。

5.3.4 Monoliner と ANALOG の見た目
 

▪ アンサンブルのパネルビューを表示するには、Panel ボタンをクリックします。

5.8Panel ボタンです。

シーケンサー機能付きシンセサイザーの作成
シンセシーケンサーの各設定
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5.9Monoliner と ANALOG です。

Monoliner はノブ列を供えており、それらでゲート、ベロシティー、ピッチをコントロールしま
す。 左の snc&pos セクションでスピードとシーケンサーの再生方向、使用するステップ数をコン
トロールします。 他のコントロールについては後ほど解説します。 特筆すべき点として、
Monoliner には内蔵 MIDI Out  を装備しています。
ANALOG にはリングモジュレーターを備えた 2 つのオシレータがあり、また 2 つのエンベロー
プと LFO 、内蔵ステレオディレイを装備しています。

5.4 インストゥルメント同士の MIDI 接続
 

上記したように、Monoliner は他の REAKTOR シンセや外部シンセに MIDI を送るよう設計され
ています。 このアンサンブル内で MIDI の伝達を行うために MIDI 接続を行う必要があります。 
設定方法は簡単です。

シーケンサー機能付きシンセサイザーの作成
インストゥルメント同士の MIDI 接続
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5.4.1 内部 MIDI コネクションの使用
 

Monoliner インストゥルメントの MIDI アウトプットを ANALOG の MIDI インプットに内部接
続する場合は、Monoliner プロパティの Connect ページで設定を行います。
1. サイドペインで、 Properties タブをクリックします。

2. Connect をクリックしてプロパティの Connect ページを表示します。

3. シーケンサーとシンセ間の MIDI 接続を行うには、Connect ページの MIDI Out エリアにあ
る Select Instruments ドロップダウンメニューで行います。ドロップダウンメニューで 
ANALOG を選択します。

4. 接続状況を確認するには、ANALOG インストゥルメントの Connect ページに進みます。 イ
ンストゥルメントを選択するには、ANALOG インストゥルメントのヘッダをクリックしま
す。

シーケンサー機能付きシンセサイザーの作成
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5. ANALOG の Connect ページがサイドペインに表示されます。 Connect ページの MIDI In 
エリア内の Select Instruments ドロップダウンメニューをクリックします。 Monoliner 

メニューエントリーの横のチェックボックスにチェックが入ります。

6. グローバルメニューから Save Ensemble As...コマンドを選択して保存します。  設定はこ
こまでなので、シーケンサーとシンセのコンビネーションを試奏してください。

5.5 REAKTOR の再生、停止ボタン
 

REAKTOR の Run 、Stop ボタンはシーケンサーの再生と停止に使用します。

再生、停止ボタンの概観
再生、停止ボタンはインストゥルメントの最上部、BPM 表示部分の横のメインツールバー(Main 
Toolbar)にあります。

シーケンサー機能付きシンセサイザーの作成
REAKTOR の再生、停止ボタン
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5.10BPM/ 再生/停止

▪ シーケンサー(Sequencer)をスタートするには、マウスでこの再生ボタンをクリックしま
す。 するとシーケンサーが再生を開始します。 MIDI アクティビティーランプが MIDI が機
能していることを表示します。 同時にシンセの音声も確認できます。

5.11MIDI アクティビティライト

シーケンサー機能付きシンセサイザーの作成
REAKTOR の再生、停止ボタン
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シーケンサーの一時停止とリセット
▪ シーケンサーの再生中に再生(Run)ボタンをシングルクリックするとシーケンサーが一時停止

し、再生ボタンをもう一度クリックすると停止した位置から再生を開始します。 停止ボタン
をクリックすることでシーケンサーを最初の再生位置へとリセットします。

5.6 Monoliner 詳細
 

スピードと再生方向コントロールの詳細について解説します。

5.6.1 再生方向と再生速度の変更
 

このシーケンサーはパターン再生において非常に柔軟です。
▪ 再生方向を反対にする、または再生内容をランダムにする場合、横の矢印をクリックして方

向リスト(direction list)を開きます。 同様に Sync メニューを使用して再生速度を変更するこ
とも可能です。

5.12Direction リストです。

シーケンサー機能付きシンセサイザーの作成
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5.13Speed　リストです。

デフォルト値は 1/16 で、 1 小節を 16th ノートに分割した状態となります。

5.6.2 ステップ数、ステップオフセット、シャッフル/スイング
 

▪ stps ノブでステップ総数を 1 から 16 まで変更します。
▪ offs ノブでシーケンサーがスタートする位置を変更します。
▪ SHFL で再生内容にスイング感を与えます。 ステップ数を 6 にし、オフセットを 9 にしてく

ださい。

5.6.3 ゲート、ベロシティー、ピッチノブとオン/オフボタン
 

▪ ノブの一番上の列、GATE で各音声の長さを設定します。
▪ 列の最後にあるノブはマスターで、全体の Gate の長さをコントロールします。
▪ 次の列、VELO で各音声の音量をコントロールします。 この列の最後にもマスターノブがあり

ます。
▪ 一番下のノブ列は PITCH で、音声の音程を調節します。
▪ ボタンで Gate のオン/オフを切り替えます。

シーケンサー機能付きシンセサイザーの作成
Monoliner 詳細
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5.14 各マスターノブです。

5.15Gate On/Off ボタンです。

5.7 スナップショット/ヒントの使用
 

ではこのシーケンサーとシンセの組み合わせを試してみましょう。

5.7.1 Monoliner と Analog のスナップショット
 

Monoliner のスナップショットは少なめですがこれらを試してみる価値は十分にあります。 この
シーケンサーの興味深いところは再生方向とステップ数を snc&pos コントロール部で設定でき
る点で、これによって様々なシーケンスの可能性を引き出します。 また rnd ボタンを押して設定を
ランダム化することも可能です。 ANALOG シンセには多数のスナップショットがあり、シーケン
サーの再生中にスナップショットを変更して色々なパターンを試してください。

5.7.2 ヒントの表示/非表示
 

ヒントを表示するにはヒントボタンを押してください。 このシンセには非常に有用なヒントを記載して
あるので、各ノブとスイッチ上にマウスを動かして説明を表示し、内容を確認してください。

シーケンサー機能付きシンセサイザーの作成
スナップショット/ヒントの使用
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5.16FM ノブのヒントです。

ここでまた編集内容を保存しましょう。
以前保存した内容に上書き保存する場合は、グローバルメニューで Save Ensemble command 
を使用します。 Save Ensemble As...コマンドで、以前保存した内容を残しておき、新規設定内
容を別名称で保存します。

シーケンサー機能付きシンセサイザーの作成
スナップショット/ヒントの使用

 

REAKTOR 5.5 - クイックスタートマニュアル - 76



6 REAKTOR のサンプラー
 

このチュートリアルではドラムキットサンプルを再生するのに便利なサンプルプレーヤーである 
Memory Drum 2 を使用します。

6.1 おさらいと概要
 

ここまでで、REAKTOR ライブラリ内の 2 つのシンセを使用したので、ここからはサンプラーの
一つを使用します。
▪ ここではサンプルマップ内のサンプルを他のサンプルに取り替える方法を解説します。
▪ そしてサンプルマップ内にサンプルを追加する方法を紹介します。
▪ MIDI キーボードを使用してサンプルマップ内でサンプルを選択する方法についても解説し、

マウスを使用してサンプルをオーディションする方法についても解説します。
▪ REAKTOR 内のサンプルマッピング(Sample Mapping )についても解説します。
▪ 最後に Memory Drum のユニークな各機能について解説します。

まずはブラウザを使用して Memory Drum 2 をロードします。

REAKTOR のサンプラー
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6.1Memory Drum 2 です。

6.2 ブラウザを使用して Memory Drum 2 を起動する。
 

1. サイドペインで Browser タブをクリックしてブラウザを開きます。

REAKTOR のサンプラー
ブラウザを使用して Memory Drum 2 を起動する。
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2. フォルダツリーで Ensembles > New Additions > Sample Player と進みます。
3. MemoryDrum2.ens をダブルクリックしてロードします。

6.2 ブラウザで Memory Drum 2 を選択してください。

Memory Drum 2 はマッピングされており、C1 で最初のサンプルを発音し、各セミトーン単位
で異なる音程のサンプルを発音します。 まずキーボードを演奏して異なるピッチで発音するか確
認してください。 サンプル音声を気に入っても自分のサンプルを割り当てる場合どうしたらよい
でしょうか? そのためにはサンプルマップエディタ(Sample Map Editor)を開いてください。

REAKTOR のサンプラー
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6.3 サンプルマップエディタでサンプルを交換、編集する
 

ここでは」サンプルマップエディタ(Sample Map Editor)を使用してサンプルを交換します。 サ
ンプルマップを開いて SEL BY KEY を使用し、MIDI キーボードでマップ上のサンプルを演奏可
能な状態にし、マウスを使用してサンプルをオーディションすることも可能な状態にします。

6.3.1 マップを開きサンプルを演奏する
 

1. サンプルの波形をダブルクリックしてください。 するとサンプルマップエディタが開きま
す。 サイドバーのサンプルマップ(Sample Map)ボタン、またはショートカットキーの [F9]
を押してエディタを開くことも可能です。

2. サンプルマップの右上の Key ボタンを押して Select Sample by Key 機能を起動します。 
これで MIDI キーボードによってサンプルを選択することが可能となります。

REAKTOR のサンプラー
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3. Sample Prehear をクリックするとオリジナルサンプルを試聴することが可能です。

6.3Sample Prehear ボタンです。

では他のサンプルを割り当ててみましょう。 ここでは MIDI ノート 48 にスネアサンプルを割り
当てます。  まずキーボードの C2 を押してこのサンプルを選択します。

6.3.2 エディットサンプルリストで Replace を選択する。
 

▪ サンプルマップエディタの左上の Edit ドロップダウンメニューを開き、Replace を選択しま
す。

REAKTOR のサンプラー
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6.4Replace で選択したサンプルを交換します。

この動作で REAKTOR 設定(Preferences)で指定したオーディオファイルを含むフォルダを表示
します。 ここでは MIDI ノート 48 スロット用の別のスネアサウンド(もちろん任意で音色を選択
することが可能です)を選択します。

6.3.3 サンプルのキースプリット(Key-Split) とルートノート(Root Note)
 

ではサンプルを確認しましょう。

6.5 サンプルマップエディタ上の Clap CloseTheBook.wav です。

REAKTOR のサンプラー
サンプルマップエディタでサンプルを交換、編集する
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L /R の両方の値が 48 となっています。 これはキーボード上でこのサンプルのキースプリット
が一つの鍵盤のみ(MIDI 48)に対応していることを意味し、ドラム音声を扱う場合通常こういった
設定が一般的となります。 ルート(Root)も 48 となります。 これはサンプルを MIDI ノート 48 
でオリジナルピッチで再生することを意味します。
サンプルの交換が済んだので、マップに新規サンプルを追加します。

6.3.4 エディットサンプルリストで Add を使用する。
 

1. サンプルリストの最後までスクロールし、MIDI ノート 77 、Sound 9 を選択します。
2. Edit ドロップダウンメニューをクリックし、Add を選択します。

6.6Add を選択してサンプルマップに新規サンプルを追加します。

REAKTOR のサンプラー
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今回は先ほど交換したサンプルがあるフォルダを開きます。 このフォルダ、または他のフォルダ
から使用するサンプルを選択してください。 もう一度選択したサンプルをダブルクリックしてマ
ップにロードします。

6.3.5 キースプリット(Key-Split)の編集
 

キースプリット(Key-split)を編集して L と R を 78 にします。 値の変更方法は以下となってい
ます。
1. 任意の数値入力欄をダブルクリックします(ここでは新規サンプルの R 欄を編集します)。
2. 新規番号を入力します。
3. 入力したら[エンター] キーを押します。 この方法でサンプルを更に追加します。

4. 自由にサンプルを追加してください。 サンプルマップの編集を終了してマップを閉じる場合
は、Sample Map ボタンをもう一度押してください。 次のセクションでは Memory Drum 
インターフェイスについて解説します。

6.7Sample Map ボタンです。

6.4 Memory Drum インターフェイス
 

各 MIDI ノート値で個別のサンプルを選択するだけでなく、各サンプルスロットの異なる性質を大
きく変更することも可能です。

REAKTOR のサンプラー
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6.4.1 一つのサンプルスロットで音程を変更する。
 

ここでは最初に置き換えたサンプルを使用してそのサンプルの音程を変更します。 Memory 
Drum では他のサンプルスロットに影響なく一つのサンプルスロットにあるサンプルの音程を変
更することが可能です。
▪ p フェーダーをクリックし、フェーダーを下げることでサンプルのピッチを変更します。

6.8.p の設定を変更することでサンプルの音程が変わります。

MIDI キーボードを使用してサンプルを演奏すると、そのサンプルの音程が下がっているはずです。
他のサウンドを演奏してもそれらの音程はこの設定前と同じです。この性質がこのサンプルプレ
ーヤーの特徴です。各サンプルサウンドスロットで全パラメーターの設定をサンプルごとで行う
ことが可能です。他のコントロール部も調整し、各サンプルのエンベロープ、フィルター設定を変
更してください。
もう少し解説します。

REAKTOR のサンプラー
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6.4.2 Memory Drum スナップショットの確認
 

6.9.Memory Drum 用スナップショットです。

Default で各サンプルの設定内容は同じです。他のスナップショットのどれかを選択し、異なる設定
内容を確認してください。異なるキーを押すことによって異なるサンプルを再生するだけでなく
その設定内容も大分デフォルトとは異なります。アンサンブルを保存する前に更にサンプルを追
加/編集し、気に入った内容をアンサンブルとして保存してください。スナップショットを変更し
た場合は、Append ボタンを使用し、スナップショット名称を変更してから保存してください。サン
プルの追加と置き換えが終了したら、Save Ensemble As... コマンド を使用して保存することも

REAKTOR のサンプラー
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忘れないでください。 この手順を行わないと、編集した内容が保存されません。 ↑8, REAKTOR 

モジュールによるサンプラーの作成。章のチュートリアルで、各サンプル再生機能(reverse, 
forward / backwards、forward / backwards reverse)について解説しています。 またサンプ
ルマップエディタでサンプルをトランスポーズする方法についても解説します。

REAKTOR のサンプラー
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7 Macros を使用したシンセの作成
 

このチュートリアルでは既存の Macros を使用してアナログスタイルのシンセを作成します。 
作成するシンセは 2 のオシレータ、ミキサー、2 つのエンベロープシェイパーとフィルターを装
備したものとなります。 ここでは上記のチュートリアルを行ったと前提し、インサートと接続方
法については把握しているものとします。

7.1 Macro とは
 

REAKTOR 5 にはあらかじめ設定してある Macro のライブラリを備えています。 一つの 
Macro 内には接続されたモジュール群が控えています。 Macro はインストゥルメントの縮小版
であるといってよいでしょう。 これらのモジュールでオシレータ、フィルター、エンベロープ、
シェイパー、ディレイ等をモジュラーシンセのように作成、またはカスタマイズします。 これら
のカスタマイズは、構築案が明確にアイディアとして考えられるようになリ、どのようにモジュー
ルを扱えばよいか判断できるようになってから行うことをお勧めします。
以下のシンセでは、境界線やタイトルによって異なる Macros の各グループを確認することがで
きます。

Macros を使用したシンセの作成
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7.1 設定を終えた状態のシンセです。

Oscillator 1 Macro にはストラクチャー内に 3 つのオシレータと Pitch、 Fine、 P-Width 、
Wave Switch の各コントロールを含んでいます。 これらは全て個別のモジュールですが、全て接
続することで Macro として成立します。

Macros を使用したシンセの作成
Macro とは
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7.2Oscillator Macro Structure ビューです。

上級者テクニックですが、アンサンブルの一部をカットし、新規 Macro にペーストして構造の分析や再
利用に活用することも可能です。

7.2 準備(Preparation)
 

まず新規アンサンブルをロードし、デフォルトインストゥルメントを削除し、必要なインストゥル
メントをインサートします。

7.2.1 新規アンサンブル(New Ensemble)のロード
 

では REAKTOR のデフォルト New Ensemble を使用します。
1. Menu ボタンをクリックし、File > New Ensemble と進みます。

Macros を使用したシンセの作成
準備(Preparation)
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アンサンブルパネルが表示されます。

7.3 新規アンサンブルのパネルビューです。

▪ Structure ボタンをクリックして構造(ストラクチャー)を表示します。

7.4Structure ボタンです。

Macros を使用したシンセの作成
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7.5 新規アンサンブルのストラクチャーです。

まずストラクチャーを編集します。

7.2.2 デフォルトインストゥルメントの削除
 

作成するシンセのアウトプットは一つにするので、2 つのアウトプット(Output L/R)を持つデフ
ォルトインストゥルメントは必要ありません。
▪ デフォルトインストゥルメントを削除するには、インストゥルメント上部で Windows® では

右クリック( Mac OS® X では[Ctrl]+クリック) し、メニューで Delete を選択します。

Macros を使用したシンセの作成
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7.6 デフォルトインストゥルメントを削除します。

次にモノシンセに必要な一つのアウトプットを持つインストゥルメントをインサートします。

7.2.3 新規インストゥルメント(New Instrument)のインサート
 

▪ 新規インストゥルメントをインサートするには、アンサンブルストラクチャーの空白部分で、
Windows®では右クリック(Mac OS®X では Ctrl+クリック)し、メニューを開きます。 
Insert Instrument >_New – 1in1out を選択します。

Macros を使用したシンセの作成
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7.7 新規インストゥルメントをインサートします。

インサートしたインストゥルメントにはインプットとアウトプットがあります。

Macros を使用したシンセの作成
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7.8 ストラクチャー内にインサートしたインストゥルメントです。

作成するシンセは Output のみを必要とするので、Input を削除します。
1. インストゥルメントをダブルクリックして展開します。
2. In Module を Mac OS®X では Ctrl-クリック、Windows®では 右クリックし、メニューを表

示します。 Delete メニューを選択し。

3. ストラクチャーの空白部分をダブルクリックしてストラクチャー構造の最浅部に移動しま
す。

7.2.4 オーディオアウトにインストゥルメントを接続する。
 

次にインストゥルメントのアウトプットを Audio Out ターミナルの 1 と 2 に接続します。
1. カーソルを Out または横の点に当てます。

Macros を使用したシンセの作成
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2. マウスをクリックホールドし、オーディオアウトモジュール(Audio Out Module)の 1 イン
プットポートとある場所へとドラッグします。

3. オーディオアウトプットモジュールの 1 またはその横の点に到達したら、マウスを放して接
続を適用します。

同じことを Instrument Out とオーディオアウトモジュールのインプットポート 2 でも行いま
す。 これによりシンセのサウンドは使用しているスピーカーの両方から出力されます。 接続は
以下のような見た目になるはずです。 インストゥルメントの右下隅の黄色ランプが接続済みであ
ることを示します。

7.9 アウトプットに接続された状態のインストゥルメントです。

7.3 オシレータと ADSR Env をインストゥルメントに接続する
 

次に、Oscillator Macro と ADSR Env を追加し、接続しましょう。 また NotePitch と Gate 
Modules を追加して、MIDI キーボードでシンセを演奏できるように設定します。

7.3.1 オシレータのインサート
 

1. まずインストゥルメント内部にアクセスしており、編集できる状態であることを確認してく
ださい。 インストゥルメント内部に移動するには、インストゥルメントのオブジェクトをダ
ブルクリックしてください。

2. インストゥルメントストラクチャーに Oscillator Macro を挿入するには、インストゥルメン
トストラクチャーの空白部を Windows® では右クリック(Mac OS® X では Ctrl+クリック)
し、 Macro > Building Blocks > Oscillators > Osc (pls, saw, tri) と進みます。 Osc 3 
Wave がインストゥルメントストラクチャーとインストゥルメントパネルに表示されます。

Macros を使用したシンセの作成
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3. インストゥルメントストラクチャー(Instrument Structure)で Osc 3 Wave Macro の Out 
からクリックドラッグして配線し Audio Voice Combiner に接続します。手順はインスト
ゥルメントとオーディオアウトプットターミナルをを接続したときと同様です。

7.10Oscillator と Audio Voice Combiner を接続してください。

Macros を使用したシンセの作成
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7.3.2 ADSR Env のインサート
 

▪ インストゥルメントストラクチャーの空白部分で Windows® では右クリック(Mac OS® X 
では Ctrl+クリック)し、 Macro > Building Blocks > Envelopes > ADSR – Env と進みま
す。

7.11ADSR-Env のインサート

7.3.3 Pitch と Gate モジュールのインサート
 

更に 2 つのコンポーネント(REAKTOR ではモジュールと呼びます)を追加する必要があります。 
Note Pitch と Gate Modules で MIDI キーボードによるシンセの演奏を可能にします。
1. インストゥルメントストラクチャーの空白部分を Windows® では右クリックし(Mac OS® 

X では Ctrl+クリック) Built-In Module > MIDI In > Note Pitch メニューへと進んで 
Note Pitch Module をストラクチャーに挿入します。

Macros を使用したシンセの作成
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2. 同様に Built-In Module > MIDI In > Gate と進んでゲートモジュールを選択します。

7.3.4 Pitch と Gate モジュールの接続
 

これらを接続して作成しているシンセを演奏できる状態に設定します。
1. 上記した内容と同じ手順で、NotePitch モジュールを Osc 3 Wave Macro の P (Pitch) イ

ンプットに接続します
2. その後 Gate モジュールを ADSR-Env Macro の G (Gate) インプットに接続します。

Macros を使用したシンセの作成
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3. 最後にストラクチャー構造内の階層最上部の ADSR- Env の Out を Osc 3 Wave Macro 
の A (Amplitude) に接続します。

ここまででシンセのストラクチャーは図のようになるはずです。

7.12 接続を終えた状態のシンセです。

7.3.5 最適なアウトプットレベル
 

シンセを演奏する前に、最適なアウトプットレベルを確保しておくのが懸命でしょう。
1. まず Panel ボタンをクリックしてアンサンブルパネルを表示します。

2. マスターインストゥルメントパネルで、Level フェーダーを-10 にします。

7.13Master Instrument を選択してアウトプットレベルを調節します。

演奏を開始し、異なる鍵盤を弾いてピッチが変化するか確認してください。

7.4 Filter のインサート
 

次に Filter Macro をインサートします。

Macros を使用したシンセの作成
Filter のインサート
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7.4.1 Filter Macro の追加と追加による接続の変更。
 

1. インストゥルメントストラクチャー内に移動してください。 ぺネルを表示している場合は、
Structure ボタンを押してください。

2. インストゥルメントオブジェクトをダブルクリックしてストラクチャー内に移動します。
3. インストゥルメントストラクチャーの空白部分で、Windows® では右-クリック(Mac OS® X 

では Ctrl+クリック)し、Macro > Building Blocks > Filters > 4 Pole Filter (BP, BLP, LP) 

と進み、選択します。

ここで配線内容を変更します。
1. クリックドラッグで、Osc 3 Wave Macro の Out と、4-Pole Filter Macro の In を接続し

ます
2. その後 4-Pole Filter の Out を、 Audio Voice Combiner の Input に繋ぎます。
ここまででシンセのストラクチャーは図のようになるはずです。

Macros を使用したシンセの作成
Filter のインサート
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ここまでで、Filter Macro をインストゥルメントのストラクチャー内に組み込みました。 ここか
らは、インストゥルメントパネルに目を向けてください。 ここでは全ての Macro が重なって表示
された状態となります。 まずはパネルをアンロックしてパネルを整頓しましょう。
▪ インストゥルメントパネルを表示するには、Panel ボタンをクリックします。

7.14Panel ボタンです。

7.4.2 Macro を移動する為にパネルをアンロックする。
 

パネルをアンロックした後、Macros を任意の位置に移動することが可能となります。
1. パネルロック(Panel Lock)ボタン をクリックしてパネルをアンロックします。 Windows® 

ではキーボードショートカット Ctrl+P (Mac OS® X では Cmd+P)を使用してパネルのロッ
ク/アンロック切り替えを行うことが可能です。

Macros を使用したシンセの作成
Filter のインサート
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ここまででシンセの見た目は図のようになります。

7.5 セカンドオシレータとミキサーを追加する。
 

太いサウンドが欲しいので、オシレータを追加します。 更にミキサーも追加して、必要な接続を
行います。

Macros を使用したシンセの作成
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7.5.1 複製(Duplicate)機能の使用によるセカンドオシレータの追加
 

他のオシレータを追加する代わりに、すでにあるオシレータを複製(duplicate)する方法もありま
す
▪ インストゥルメントストラクチャー(Instrument Structure)に戻り、Osc 3 Wave Macro 

の上部を Windows® では右クリック(Mac OS® X では Ctrl+クリック)し、Duplicate をク
リックして選択します。

7.15 オシレータを複製します。

古い Osc 3 Wave Macro の上に、コピーが現れます。

Macros を使用したシンセの作成
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7.5.2 プロパティを使用してオシレータ Macro の名称を変更する。
 

現在両方のオシレータの名称が重複しているので各名称を変更します。
1. 最初の Osc 3 Wave Macro の上部を Windows® では右クリック(Mac OS® X では Ctrl

+クリック)し、Properties をクリックして選択します。 これでこのマクロ用のプロパティを
表示します。

2. テキスト入力エリア(ラベルエリアと呼びます)をクリックし、“Oscillator 1” と入力し、エン
ターキーを押します。

3. もう一つのオシレータも同様の手順で Oscillator 2 と名称を変更します。

Macros を使用したシンセの作成
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7.16Properties タブのラベルエリア内で名称を入力します。

7.5.3 Mixer の追加
 

ここまでで、2 つのオシレータを設置したので、 ミキサーを追加して各オシレータの音量をコン
トロール可能な状態にします。 ここでは、Amp/Mixer モジュールが必要です。 その後接続を行
い、ミキサーインプットの数を増やします。
▪ ミキサーをインサートするには、インストゥルメントストラクチャー内の空白部分を 

Windows® では右クリック(Mac OS® X では Ctrl+クリック)し、Built-In Module > Signal 
Path > Amp/Mixer と進みます。
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7.17Mixer をインサートします。

Oscillator 1 と 2 のアウトプットを Mixer に接続してください
▪ Oscillator 1 の Out をクリックドラッグして、Mixer モジュールの In に繋ぎます。

Macros を使用したシンセの作成
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7.18Oscillator 1 を Mixer に接続します。

7.5.4 ミキサーインプット数を増やす
 

ミキサーのインプットは現在 1 個のみです。 ここではインプット数を 2 つに増やします。
▪ 2 番目の接続を行うには、Oscillator 2 の Out から Mixer モジュールの緑の部分に移動する

際に、Windows® では Ctrl+ドラッグ、Mac OS® X では Cmd+ドラッグ (ドラッグしてい
る間に Cmd/Ctrl)して接続します。 接続先に到達すると、この新規ポートへの接続が完了し
ます。

Mixer のアウトプットと、4-Pole Filter を接続するとシンセの全接続は図のようになります。

7.19 オシレータとフィルターをミキサーに接続した状態です。

Macros を使用したシンセの作成
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7.5.5 フェーダーを追加してミキサーに接続する。
 

オシレータのレベルをコントロールする Faders を追加する必要があります。
▪ ミキサーモジュールの Lvl Input で Windows® では右クリック、 (Mac OS® X では Ctrl

+クリック) して Create Control を選択します。 これでフェーダーが追加されます。

7.20 メニューを使用してインプット用コントロール部を作成します。

7.21 接続したフェーダーです。

Macros を使用したシンセの作成
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ミキサーの 2 つ目の Lvl インプットも同様に追加し、フェーダーを 2 つにします。

7.5.6 複製(Duplicate)機能を使用して 2 番目の ADSR-Env を追加する。
 

パネルを整頓する前に、ADSR-Env を複製しフィルターエンベロープの調節に使用します。 
ADSR-Env Macro で Windows® では右クリック(Mac OS® X では Ctrl+クリック)し、メニュー
で Duplicate を選択します。 4-Pole Filter の PM (Pitch Modulation) Input と 2 番目の 
ADSR-Env Macro Out を接続すると、ストラクチャーはこのようになります。

7.222 番目の ADSR-Env を接続した状態のストラクチャーです。

7.5.7 ノートピッチモジュール(NotePitch Module) と ADSR エンベロープ
とフィルター(ADSR Envelopes and Filter)を接続する。

 

まだ行っていない重要な接続があります。 NotePitch モジュールを Macro の P (Pitch) Inputs 
の全てに接続する必要があります。これでインストゥルメントの音階設定を行い、音程が高くなる
ほど、サウンドが明るくそして短くなります。
▪ 接続は NotePitch Module の赤いアウトプットをクリックホールドし、ADSR-Env と 4-

Pole Filter を含む Macro の全ての P Inputs にドラッグします。以上を行うと、ストラクチ
ャーはこうなります。
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7.23NotePitch モジュールに追加接続を施します。

7.5.8 インストゥルメントパネル(Instrument Panel)の整理
 

では整理しましょう。 パネルロック(Panel Lock)ボタン をクリックしてパネルをアンロックし
ます。

7.24Panel Lock ボタンです。

の名称部分をクリックして移動します。 その Macro を選択すると赤く表示されます。 複数選択
するには Shift+クリックで移動対象をドラッグして囲みます。 各 Macro を移動するとこうなり
ます。
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7.25 マクロを整頓し終わった後のシンセのパネルです。

ADSR-Env の名称変更
2 つの ADSR-Env Macro が現在同じ名称になっています。ここでは 2 番目の ADSR-Env の名
称を変更して区別します。名称変更は Macro のプロパティで行います。
1. インストゥルメントのストラクチャー内で、Filter Macro に接続してある ADSR-Env 

Macro を Windows® では右クリック(Mac OS® X では Ctrl+クリック)し、メニューで
Properties をクリックします。

Macros を使用したシンセの作成
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2. テキスト入力エリア(ラベルエリアと呼びます)をクリックし、“Filter Env” と入力し、エンタ
ーキーを押します。

7.5.9 フェーダーの見た目の変更
 

REAKTOR ではフェーダーの見た目をノブに変更することも可能です。 ノブはスペースの節約
するのですっきりとし、操作もしやすくなる場合があります。 このままフェーダーを使用する場
合は、この項目はスキップしてください。 見た目を変更する場合は、もう一度 REAKTOR のプロ
パティを使用して View ボタンをクリックします。
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1. フェーダーを Windows® では右クリック（Mac OS® X では Ctrl+クリック)し、プロパティ
(Properties)を開きます。

2. View をクリックしてビューページを開いてください。

3. Vertical Fader から Knob 二コントローラーの形状を変更します。

4. 他のフェーダーでも同様の作業を繰り返します。この作業中に各ノブの名称を Osc 1 Level 
と Osc 2 Level としておけば更に便利でしょう。

Macros を使用したシンセの作成
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7.6 シンセを操作してサウンドを変化させる。
 

ここからは実際にシンセを操作して、フィルターとオシレータを調節してスナップショットを作成
しましょう。その後保存作業を行います。

7.6.1 オシレータ波形の変更、フィルターとアウトプットレベルの調整
 

現在のシンセサウンドは少しこもっています。 そんなときはまず Wave スイッチを使用してオ
シレータの波形を Saw にし、フィルターの Cutoff コントロール(Filter Cutoff Control)を右に回
します。

Macros を使用したシンセの作成
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7.26 変更した Filter と Oscillator の設定です。

▪ アウトプットレベル(Output Level)は -20 程度にします。

7.27 音量が大きくなりすぎないように調節します。

Macros を使用したシンセの作成
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7.6.2 スナップショットの作成
 

フィルターの Mod Amt ノブを使用して異なるサウンド設定を試してください。 このノブで Filter-
Env が Filter を変調する値を設定します。 また各エンベロープの A、D、S、R (Attack Decay 
Sustain Release) ノブも試してください。 2 つのオシレータの Pitch と Osc Level の設定を変更す
るのもよいでしょう。 設定したサウンドが気に入ったら、スナップショットとして保存してくだ
さい。 スナップショットの保存は 2-Osc と Junatik シンセを解説した際にすでに行っています。
1. サイドペインを開き、Snapshot タブをクリックします。

2. スナップショットリストの下にある Append をクリックします。

3. スナップショットの名称を入力してエンターキーを押します。

7.6.3 Save As を使用した保存
 

スナップショットを作成したら、保存するのを忘れないでください。
▪ ここではシステムショートカットを使用します。Windows® では Ctrl+Shift+S ( Mac OS® 

X では Shift+Cmd+S) をクリックして Save Ensemble As...コマンドを実行します。User 
Folder に移動する必要がある場合があります。

Macros を使用したシンセの作成
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8 REAKTOR モジュールによるサンプラーの作成。
 

ここからは、REAKTOR モジュールでサンプラーを作成します。

8.1 おさらいと概要
 

▪ サンプルに関しては REAKTOR のサンプラー Memory Drum 2 のセクションでも解説し
ました。

▪ すでに REAKTOR Macro を使用してシンセを作成しました。
▪ ここからは REAKTOR モジュールを使用して白紙の状態からサンプラーを作成します。

8.2 作成するサンプラーの内容
 

ここではボーカルループやドローン、サウンドエフェクト等の再生に最適なサンプラーを作成しま
す。
このサンプラーでサンプルを通常再生、逆回転再生、通常/逆再生することが可能です。
ここでは REAKTOR　のベーシックサンプラーモジュールを使用します。 エンベロープとフィ
ルターモジュール(Envelope /Filter Module)も使用してエンベロープ用のアタック、ディケイ、
サステイン、リリース 、フィルター用のカットオフとレゾナンスコントロール各部を接続します。

REAKTOR モジュールによるサンプラーの作成。
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8.1 完成したサンプラーです。

8.3 基本構造の組み立て
 

基本的に最初に行うことはシンセを作成した時と同等です。 まずは、新規アンサンブル(New 
Ensemble)を開きましょう。

8.3.1 新規アンサンブルのロード
 

▪ Menu ボタンをクリックし、File > New Ensemble と進みます。

REAKTOR モジュールによるサンプラーの作成。
基本構造の組み立て
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8.2 新規アンサンブルを作成します。

ここではデフォルトの Stereo In/Stereo Out インストゥルメントを使用します。 これでサンプ
ラーで左右アウトプットを使用できるようになります。

8.3.2 最初のモジュールのインサート
 

では Sampler Module  と Pitch 及び、Gate モジュールをインサートしましょう。
1. Structure ボタンをクリックしてアンサンブルストラクチャーを表示します。
2. アンサンブルストラクチャーでインストゥルメントをダブルクリックし、モジュールを追加

可能な状態にします。
3. インストゥルメントストラクチャーの空白部分で Windows® では右クリック(Mac OS® X 

では Ctrl+クリック) し、メニュー内を Built-In Module > Sampler > Sampler と進みます。

REAKTOR モジュールによるサンプラーの作成。
基本構造の組み立て

 

REAKTOR 5.5 - クイックスタートマニュアル - 120



4. 次に NotePitch と Gate モジュールをインサートします。 このモジュールはシンセを作成
した時にも使用しました。 メニューで Built-In Module > MIDI In > NotePitch を選択し、
同様にストラクチャーコンテクストメニューで Built-In Module > MIDI In > Gate と進み
ます。

以上を行うと、ストラクチャーはこうなります。

REAKTOR モジュールによるサンプラーの作成。
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8.3.3 Envelope のインサート
 

次に ADSR Envelope をインサートし、アタック、ディケイ、サステイン、リリースをコントロ
ールします。
インストゥルメントの空白部分を Windows® では右クリック(Mac OS® X では Ctrl+クリック) 
し、メニュー内を Built-In Module > LFO, Envelope > ADSR と進みます。

REAKTOR モジュールによるサンプラーの作成。
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8.3ADSR モジュールをインサートします。

8.3.4 エンベロープ用コントローラーを追加する。
 

コントロール(Controls)を作成する手順は、シンセのミキサーにフェーダーを追加した手順と同様
です。
1. エンベロープにアタックフェーダーを追加するには、A 、または赤い点の上で Windows® で

は右クリック(Mac OS® X では Ctrl+クリック) し、 Create Control を選択します。

REAKTOR モジュールによるサンプラーの作成。
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2. エンベロープの各 D、 S、R Input にも同様の作業を行ってください。
ここまででストラクチャーの見た目が図のようになります。

8.4 接続作業
 

ここでは、サンプラーをアウトプットに接続し、Gate と NotePitch モジュールを ADSR-Env に
クリックホールドドラッグで接続します。

REAKTOR モジュールによるサンプラーの作成。
接続作業
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8.4.1 サンプラーを 2  つの オーディオボイスコンバイナー(Audio Voice 
Combiners)に接続する。

 

1. サンプラーの Out ドットをクリックし、マウスをホールドしたまま左の Audio Voice 
Combiner にドラッグします。

2. Audio Voice Combiner の黒いドットに到達したら、マウスを放します。これで配線が完了
します

3. 右の Audio Voice Combiner でも同様のことを繰り返します。
黄色いランプが接続が完了したことを示します。

8.4 サンプラーと Audio Voice Combiners を接続した状態です。

8.4.2 NotePitch と Gate モジュールの接続
 

1. NotePitch モジュールの赤いドットをクリックホールドし、サンプラーの P (Pitch) Input 
に接続します

2. 赤いドットに到達したらマウスを放します
3. Gate モジュールでも同様の作業を行い、サンプラーの Trig Input  を ADSR-EnvG (Gate) 

Input に接続します。
以上を行うと、ストラクチャーはこうなります。

REAKTOR モジュールによるサンプラーの作成。
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8.5 サンプラーにサンプルをロードする。
 

ここまでで簡単なサンプラーが完成したので、サンプルをロードして音が鳴るか確認してみましょ
う。
まずサンプルマップエディタ(Sample Map Editor) を開いてください。

8.5.1 View メニューからサンプルマップエディタ(Sample Map Editor)を
開く。

 

▪ サイドバーの Sample Map ボタンをクリックします。

8.5Sample Map ボタンです。

インストゥルメントの下に サンプルマップエディタ(Sample Map Editor)が開きます。

REAKTOR モジュールによるサンプラーの作成。
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Sample Map Editor で、Memory Drum 2 で行った作業と同様に、サンプルマップ(Sample 
Map)にサンプルを追加します。

8.5.2 サンプルマップエディタにサンプルを追加する。
 

▪ サンプルマップにサンプルを追加するには、Edit ドロップダウンメニューで Add を選択しま
す。

REAKTOR モジュールによるサンプラーの作成。
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8.6 サンプルを追加するために Edit ドロップダウンメニューを使用します。

これでオーディオフォルダを開きます。ここからボーカルループやサウンドエフェクト、ドローン
等を収納しているフォルダへと進みます。 ”Open” をクリックすると、選択したサンプルがサンプ
ルマップ上に配置されます。

8.7 サンプルを配置しました。

これで MIDI キーボードを演奏すると、サンプルを異なる音程で演奏することが可能となります。

REAKTOR モジュールによるサンプラーの作成。
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8.6 モジュールの見た目の変更と整理
 

ここではストラクチャーパネルのモジュールを整理し、アンサンブルパネル内での見た目を変更し
ます。
これによりストラクチャー構造を明確に確認することが可能となり、モジュール追加の為の余白を
確保することが可能となります。

8.6.1 ストラクチャー内でモジュールを移動する。
 

モジュールをハイライト表示することで移動、ストラクチャー内を整理してください。
1. まず Note Pitch、Sampler、Audio Voice Combiners、L と R Output を Shift-クリック

して移動してください。

2. モジュールを下げ、左に動かしてください。
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8.6.2 必要ないモジュールの削除
 

1. L と R Audio Inputs は必要ないので削除します。
2. Shift-クリックでこのモジュールをハイライト表示します。
3. 選択したモジュール上で Windows® では右クリック(Mac OS® X では Ctrl+クリック)し、

メニューから Delete Selection を選択してストラクチャーからモジュールを削除します。

REAKTOR モジュールによるサンプラーの作成。
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8.8Delete Selection を選択します。

8.6.3 パネルロックボタンを使用してノブを移動する。
 

ADSR のコントロール部はアンサンブルパネル(Ensemble Panel)で重なって表示されています。
パネルをアンロックして各ノブを他の位置に移動する必要があります。
1. Panel ボタンをクリックしてインストゥルメントパネルを表示します。

2. パネルロック(Panel Lock)ボタン をクリックしてパネルをアンロックします。

REAKTOR モジュールによるサンプラーの作成。
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ここまでで、インストゥルメントパネルはこうなります。

8.9 整頓したパネルです。

REAKTOR モジュールによるサンプラーの作成。
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8.7 更にサンプルを追加してセッティングを変更する。
 

このサンプラーで異なるサンプルループを異なるキーで演奏したいので、サンプルマップ(Sample 
Map)を変更してサンプルを追加します。 サンプルマップエディタ(Sample Map Editor)をもう
一度開いてください。

8.7.1 波形をダブルクリックしてサンプルマップを開く
 

インストゥルメントのパネルは整理してあるので、 サンプルの波形の部分をダブルクリックして
サンプルマップエディタを開きます。

8.7.2 すでにあるサンプルの設定を編集する。
 

サンプルを更に追加する前に、すでにあるサンプルの設定を変更する必要があります。ここでの設
定目的は、サンプルを MIDI ノート 48 を起点として、MIDI キーボードの白鍵盤に割り当てるこ
とです。
まずサンプルが MIDI ノート 48 で再生されるか確認してください。またこのノートのみで再生
されるか確認してください。

8.7.3 キースプリット(Key-Split)とルートキー(Root Key)の設定
 

1. MIDI ノート 48 上でサンプルをオリジナル音程で再生するよう設定します。 まず初めに行
う設定は現在 60 – 48 となっているルートノート(Root Note)の変更です。 Root の数値を
ダブルクリックして新規設定値を入力してください。

2. 指定した鍵盤のみででサンプルを再生するようにしたいので、Single Key Mode を起動しま
す。 Edit ドロップダウンメニューで Single Key Mode メニューを選択すると起動します。

REAKTOR モジュールによるサンプラーの作成。
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3. これで L/R 両方の Key-Split マッピングを 48 に変更可能となります。 サンプルをハイラ
イト表示し、任意の場所でエントリーをダブルクリック(L または R)、新しく値を入力しま
す。 入力を終えたらコンピュータのキーボードのエンターキーを押します。

これでサンプルはオリジナルピッチで MIDI ノート 48 上のみで再生されます。

8.10 サンプルの再マッピングです。

REAKTOR モジュールによるサンプラーの作成。
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8.7.4 更にサンプルを追加する。
 

ここで他のサンプルを追加、MIDI ノート 50 にマッピングします。
1. もう一度 Edit ドロップダウンメニュー Add を使用して、他のサンプルを追加します。
2. サンプルをマッピングし、L/R キースプリットを 50 にします。
3. 同様の方法で、更にもう 2 つのサンプルを追加します。 これらのサンプルも白鍵盤に配置し

たいので、次のサンプルも L/R の両方、ルートを 52 と設定します。
4. 4 番目のサンプルにも L/ R 、Root を 53 に設定します。
ここまでで、4 つのサンプルを C2、 D2、 E2、F2 の各ノート(MIDI ノート 48、 50、 52、53)
で演奏することが可能となります。
サンプルマップの見た目はこうなるはずです。

8.114 つのサンプルが各鍵盤にマッピングされた状態です。

MIDI ノート 55、57、59、 60 に更にサンプルを追加するのもよいでしょう。 このチュートリア
ルではその説明は省き、サンプルプレイバックの解説に移ります。 ここではサンプルプレイバッ
クの再生方向の変更について解説します。

REAKTOR モジュールによるサンプラーの作成。
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8.8 サンプルリバースとその他の再生方法
 

ここではループの逆再生とサンプル音程の変更について解説します。

8.8.1 ルーピングと再生方向ボタン
 

このサンプラーはシンプルですが、各サンプルに再生に関する異なる性質を設定することが可能で
す。 サンプルマップエディタで各機能を確認しましょう。 サンプル波形の下に Loop、Reverse、
Alternating Loop 用の各ボタンがあります。

8.12Loop、 Reverse、 Alternating Loop 用各ボタンとチェックボックスです。

これら 3 つのボタンのデフォルト設定は off です。
1. Key ボタンが起動しているか確認し、MIDI キーボードでサンプルを選択できる状態にしてく

ださい。 まず MIDI ノート 48 を設定しましょう。

REAKTOR モジュールによるサンプラーの作成。
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2. 次に Loop ボタンをクリックしてバックライトが点灯した状態にします。
3. MIDI キーボードを使用して編集している鍵盤を押し続けてください。 すると、サンプルはル

ープ再生を開始します。 
4. 次に Reverse ボックスにチェックを入れます。

これでサンプルがリバース再生されます。
Alternate にチェックを入れると再生方向が通常再生、逆再生を繰り返します。

様々な再生方向を試してください。
各サンプルで異なる設定を施すことが可能です。

同じサンプルを異なるキーに割り当てて、異なる設定を行うのもよいでしょう。

8.8.2 サンプルのトランスポーズ
 

現在各サンプルのピッチはオリジナル音程となっています。
▪ Root 設定を使用してピッチを変更します。

ここではルートノートを 7 セミトーン分上げてサンプルを 7 セミトーン分トランスポーズしま
す。

REAKTOR モジュールによるサンプラーの作成。
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8.13 サンプルをトランスポーズします。

8.9 フィルターの追加
 

サンプラーにフィルターを追加して、カットオフとレゾナンスを調整できる状態にしましょう。こ
こでは各フィルター(High Pass、 Band Pass、 Low Pass)を使用します。

8.9.1 ストラクチャーにフィルターを追加する。
 

インストゥルメントストラクチャーの空白部分で Windows® では右クリック(Mac OS® X では 
Ctrl+クリック) し、メニュー内を Built-In Module > Filter > Multi 2-Pole と進みます。

REAKTOR モジュールによるサンプラーの作成。
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8.14 フィルターの挿入

8.9.2 フィルターコントロール部の作成と接続
 

ここでは P (Pitch Cutoff) Input と Res (Resonance) Input のコントロール部を作成します。
1. 各インプット上でで Windows® では右クリック(Mac OS® X では Ctrl+クリック) し、

Create Control を選択します。

REAKTOR モジュールによるサンプラーの作成。
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2. Multi 2-Pole の Input にサンプラーの Output を接続し、Filter の LP (Lowpass ) Output 
のアウトプットを、各 オーディオボイスコンバイナー(Audio Voice Combiners) に接続し
ます。

モジュールを移動して整理し終えると、ストラクチャーの見た目はこうなるはずです。

8.15 ストラクチャー内の、コントローラーを追加した状態のフィルターです。

8.9.3 インストゥルメントパネル(Instrument Panel)の整理
 

▪ もう一度パネルをアンロックし、Cutoff と Resonance ノブを整頓してください。 移動して各コ
ントロール部を操作可能な状態にしてください。

ここまでで、インストゥルメントパネルはこうなります。

REAKTOR モジュールによるサンプラーの作成。
フィルターの追加

 

REAKTOR 5.5 - クイックスタートマニュアル - 140



8.16 整頓したパネルです。

8.9.4 Band-Pass、Hi-Pass フィルターアウトプットを試す/インストゥルメ
ントの保存

 

サンプラーで Band-Pass または High-Pass フィルターを使用すると、Low-Pass フィルターを
使用するよりもよい結果を得られる場合があるでしょう。
1. その前に、Menu ボタンをクリックし、Save Ensemble As... を選択してアンサンブルを保

存します。
2. 保存を終えたら、各 Filter Outputs を試してみましょう。インストゥルメントストラクチャ

ー(Instrument Structure)内で、Multi 2-Pole の  BP Output から Audio Voice 
Combiners に配線します。

REAKTOR モジュールによるサンプラーの作成。
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3. MIDI キーボードを演奏しながら Filter と ADSR の設定を変更してください。

4. 最後に HP Output を 2 つの Audio Voice Combiners に接続します。 その後どのフィル
ターアウトがベストか決定してください。

5. 編集内容の保存

REAKTOR モジュールによるサンプラーの作成。
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8.9.5 Save Ensemble を使用してここまでのサンプラーの編集内容を保存す
る。

 

これまでに Save Ensemble As... コマンドを使用して新規にアンサンブルを保存したので、ここ
では Save Ensemble コマンドを使用して以前保存した内容の更新内容を追加保存します。
▪ Menu ボタンを押して File > Save Ensemble を選択します。

8.17 アンサンブルの保存

Filter を更に柔軟にする為の方法があります。 もしこの編集を行うなら、次のセクションに進んで
ください。 そうでない場合は、次のセクションはスキップしてください。

8.10 既存のサンプラーの改造
 

このセクションではサンプラー内の Filter 部分をより柔軟にする為の改造を行います。

REAKTOR モジュールによるサンプラーの作成。
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8.10.1クロスフェードに使用するセレクター(Selector)
 

3 つの Filter をクロスフェードすることによって切り替え(Hi Pas、Band Pass、 Low Pass)、最
適な設定を選択できるようにすることができます。 この機能を追加すると、ストラクチャーの見
た目はこうなります。

8.18 セレクターモジュールを備えたストラクチャーです。

Selector には 3 Inputs とポジションフェーダーがあります。
ポジションフェーダー(Position Fader)で 3 つの Filter を Hi Pass、Band Pass、Low Pass 間
でクロスフェードします。クロスフェーダーによって Hi Pass と Band Pass による効果をミッ
クスすることが可能です。設定方法は以下の通りです。

8.10.2Selector のインサート
 

Selector モジュールをインサートして、3 Outputs と Filter を配線します。その後 Position 
Fader を作成し、Output と 2 つの Audio Voice Combiners を接続する必要があります
▪ 次に、インストゥルメントストラクチャーの空白部分を Windows® では右クリック( Mac 

OS® X では Ctrl+クリック)して Built-In Module > Signal Path > Selector/Scanner を選
択します。

REAKTOR モジュールによるサンプラーの作成。
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8.19Selector Module を追加します。

8.10.3各 Filter Output の接続
 

1. まず Filter の HP Output を Selector の 0 Input に接続します。
2. HP Output の脇にある黒点をクリックホールドし、Selector へと配線します。
3. 指カーソルが 0 Input の脇にある青点に到達したら、マウスを放して接続します。
Selector Input インプットが黒くなり、オーディオ接続が完了したことを示します。

REAKTOR モジュールによるサンプラーの作成。
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8.20Filter と Selector が接続された状態です。

8.10.4Selector インプット数を増やす
 

Selector のインプット数を増やし、3 つの Filter Output を接続できるようにします。
1. BP Output　から Selector にドラッグするしつつ、Mac OS® X の Cmd key  または 

Windows® Ctrl キーを押します。
2. 先ほど Selector に施した配線部分の下に新規インプットを接続します。
3. LP Output と 3 番目の Selector Input 間でも同様に配線を行います。
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8.21Selector インプットが Filter アウトプットに接続された状態です。

8.10.5ポジションフェーダー(Position Fader)を追加してレンジを変更する。
 

1. セレクターにフェーダーを追加する場合は、セレクターの Pos Input 上で Windows® では
右クリック、(Mac OS® X では Ctrl+クリック) し、メニューで Create Control を選択しま
す。

2. プロパティで フェーダーのレンジを変更する必要があります。 ストラクチャー内のフェー
ダーをダブルクリックして行ってください。

REAKTOR モジュールによるサンプラーの作成。
既存のサンプラーの改造
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3. Function ボタンをクリックしてフェーダープロパティーの Function ページを表示します。

4. Max の数値を 2 にします。

ポジションフェーダーはここまでの設定で設定幅が 0、 1、2 となりました。これによって 3 つの
フェーダーアウトプット間を移動することが可能となりました。

8.10.6各接続とパネルの最終調整
 

最後に Selector を 2 つの Audio Voice Combiners に接続します。

REAKTOR モジュールによるサンプラーの作成。
既存のサンプラーの改造
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▪ クリックホールドドラッグして Audio Voice Combiners の Input に接続します。
Selector の接続を終え、整頓すると、ストラクチャーはこうなります。

8.22 接続が完了した状態です。

▪ パネルロックボタンをクリックしてインストゥルメントパネルをアンロックし、Pos Fader 
を右にドラッグして整理します。

8.23 Panel Lock ボタンです。

REAKTOR モジュールによるサンプラーの作成。
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8.24 移動した Position Fader です。

▪ もう一度 Panel Lock ボタンをクリックしてパネルをロックします。

8.10.7サンプラーを使用してスナップショットを作成する。
 

1. 作成したサンプラーを編集して、好みのスナップショットを保存してください。

REAKTOR モジュールによるサンプラーの作成。
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2. スナップショットの保存は Snapshot タブをクリックして Append ボタンを使用すること
で行います。

8.25Snapshot タブです。

8.26Append を使用します。

REAKTOR モジュールによるサンプラーの作成。
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新規スナップショットを保存するにはアンサンブルも保存する必要があります。 もう一度 Save 
Ensemble コマンドを使用し、または Selector がない状態のサンプラーを保存する場合は、Save 
Ensemble As コマンドを使用して新規名称を入力、用途に合った方法で保存してください。

REAKTOR モジュールによるサンプラーの作成。
既存のサンプラーの改造
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9 次は?
 

REAKTOR スタートアップガイドのチュートリアルはここまでです。更なる設定に関しては 
REAKTOR に付属するその他のマニュアルを参照してください。または当社ウェブサイトの 
REAKTOR ユーザーフォーラムで最新のヒント、日々増え続ける Instruments と Ensembles を
手に入れてください
REAKTOR を存分にお楽しみください、そしてあなたのサウンドをユーザーコミュニティーで共
有してください。

次は?
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